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QSoft Data Tracking 

What is QSoft Data Tracking? 
QSoft Data Tracking is a database system for storing details of biological samples that have 
been manipulated by the modules available for Genetix robots and instruments. These modules 
currently include: Colony Picking, Gridding, Rearraying, Replicating, Microarraying, Liquid 
Handling and Yeast-2-Hybrid.  

The system consists of a database and a user interface for querying this database to identify the 
contents of a given receptacle (well plate, bioassay tray, slide or filter).  

The database stores information about each sample - including the receptacle that each sample 
exists in. The Data Tracking system will also allow you to store details of colony properties such 
as size, average intensity (useful for GFP analysis), and location. 

The system does not currently store details of processes such as DNA sequencing which has 
been performed by non-Genetix robots. However samples can be annotated manually if 
required. The system is designed as an efficient mechanism for collating, storing and querying 
sample information as samples pass through Genetix robots.  

Each run of a Genetix robot module generates a set of log files, the one that is relevant to Data 
Tracking is an XML file with a filename in the following format:  

QSoft Log Date Time DT.XML  

This file contains details of each receptacle accessed during the run and the movement of 
samples between receptacles (e.g. from well plates to filters during Gridding). These files are 
then imported into the database to reflect the changes made during the run. 

Data Tracking relies on being able to uniquely identify each receptacle for which information is 
stored. This is achieved by applying a barcode to each receptacle. The database can be queried 
by entering a barcode to view all of the samples contained in that receptacle (arranged by 
location). Multiple samples can be stored in a given location if required e.g. where samples have 
been pooled or in Yeast-2-Hybrid experiments where each colony represents a bait and prey. 
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 QSoft Data Tracking Software 

Overview 
Start the application by double-clicking the QSoft Data Tracking icon on your Windows® 
desktop. 

 
Figure 1: QSoft Data Tracking Icon 
 
The first time that you run Data Tracking you will be prompted to connect to a database using 
the login screen.  

 
Figure 2: Login Dialog 
 
Enter the required details as described below. 

Server 
Displays the location of the database to log into. The default is the data tracking database on the 
local machine as shown in the screen above – you will only need to change this if a separate 
data tracking server exists on your network. 
 

Database 
The database name defaults to “DataTrack” – you will only need to change this if you are using 
another database that exists on a separate data tracking server on your network. 
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User Name 
Allows login to the database – enter dtuser as shown in the screen above. There is currently no 
facility to change the user name. 

Password 
Allows login to the database – enter dtuserpw. Please note that the password is case sensitive 
so type it exactly as shown. There is currently no facility to change the password. 

Use these settings next time 
Tick this box to override the password security. If this box is ticked you will not be prompted to 
log in every time you run Data Tracking. 

If you want to display this dialog again you can access it by opening the File menu and choosing 
Select Database. 
 

QSoft Data Tracking Application Window 
The setup window is very similar in layout to many typical Microsoft® Windows applications. The 
setup window is split into 2 panes.  

Commands can be selected by dropping down the appropriate menu or clicking the relevant 
button on the toolbar. 

               
Figure 3: Data Tracking Opening Screen 

Navigation Pane 

Menu bar 

Toolbar 

Information Pane 
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Title Bar 
The topmost section of the setup screen is the title bar, it displays the name of the current 
database. 
 

Menu Bar 
The menu bar commands are described in detail in the section headed The Menu Options 
(below). 
 

Toolbar 
The toolbar provides shortcuts for the most commonly used commands. All have equivalent 
options in the menus. 
 

Navigation Pane 
The navigation pane is on the left-hand side of the screen. 
 

Groups 
Displays a list of the groups of receptacles in the database. 
 

Highlight the Groups icon, a list of the groups in this database will be displayed in the 
Information pane. 
 

Display Receptacles 
Double-click a group name in the Information pane to show all receptacles within that group. 
 

Display Samples 
Double-click a receptacle name in the Information pane to show all samples in the selected 
receptacle. 

For each sample this lists the location (as a grid co-ordinate or well location), accession number 
and name (if allocated) as well as a brief description and any annotation that has been stored. 
 

Display Sample History 
Double-click a sample name in the Information pane to show all processes that have involved 
this sample – every source and destination location along with the dates and times that the 
transfers took place. 
 

Display Processes 
If you double-click a history item, the Processes list is displayed with a highlight to indicate this 
items position in the order of all the processes imported into Data Tracking. 
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Processes 
Displays a list of the processes that have been imported into the current database. Typically a 
process might be a routine previously performed on the data such as Picking, Gridding etc. (by 
importing the Data Tracking XML file) or an import from QSoft Library Manager into a Data 
Tracking database. 
 

Receptacle Types 
Select this to display all types of receptacles used in the current database. Receptacles are 
containers such as well plates, bioassay trays, slides and filters. 
 

Audit Log 
Shows the date and time of all changes that have been made to the database. 
 

Information Pane 
The Information Pane is the right-hand section of the screen. Details of the selected item are 
displayed in this pane. 

The data displayed here can be sorted by field (column), to do this click the relevant column 
header. 

Summary information about the selected item is shown on the left hand side of this pane. 
 

The Menu Options 
QSoft Data Tracking contains drop down menus that can be accessed by pointing with the 
mouse and clicking the left mouse button. 
 

File 
The File menu contains facilities for data file operations. 

 
Figure 4: File Menu 
 
New 
New Data – Allows the addition of more plate(s). Either add the plates to an existing group or 
create a new group. A wizard will guide you through the steps for adding new data. The first 
dialog prompts you to select a group name from the list or type in a new group name. Next, 
select the correct plate type. 
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Figure 5: Add or Select Group 
 
Click Next then, 

Click the Plate Range button. 

 
Figure 6: Enter Range Details 
 

Plate Name Prefix - You can either accept the default plate name prefix or create your own. 
 

Plate No Template – There are six predefined templates for plate name styles, however 
custom templates can be defined. 

Note - Defined templates will overwrite an existing template. 
 

To define a custom template: 

 select the template number to overwrite 
 type in the custom prefix 
 set values for start and end plates 
 type in the custom suffix  
 click OK 

 
Start Plate No - Define the first plate number to add. 

Note: If plates have previously been added to the library, the number entered must be greater 
than the number of the last existing plate. 
 

End Plate No – Define the end of the range by specifying a plate number.  
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Plate Name Suffix - Either accept the default, predefined, plate name suffix or create a suffix. 

Note: An example of what has been defined appears at the bottom of the screen. The template 
option saves what has been defined, so by selecting the template the defined settings for that 
number will appear.  

Update Barcodes – This check box will create a barcode matching the plate name.  

Note: Barcodes cannot be generated for an existing range of plates. If creating barcodes was 
omitted then the range will need to be deleted and re-created with the Update Barcodes option 
checked. 

Create Receptacles – Click this button when satisfied with the plate settings. 

Click Next to display the following dialog. 

 
Figure 7: Populate Plate Details 
 
Drop down the list of Receptacles and select each one to populate the list of wells for that plate.  

If required, other information can be entered for each well e.g. Description, Accession number. 

Click Next then click Export Samples. 

When the Export process has finished, click Finish to close the wizard. 
 

Select Database 
Displays the login dialog to allows connection to a different database or login as a different user. 
 

Exit 
Click this to quit the application. 
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Search 
The Search menu opens a dialog in the Navigation pane which offers the facility to locate a 
receptacle or sample according to a specific barcode or keyword with optional restrictions on the 
search criteria.  

 
Figure 8: Search by Receptacles 
 
 
Search by Receptacles 
Barcode 
Enter either a complete barcode or part of a barcode.  
 

Description 
Enter text known to be in a container’s description field. 
 

Group 

Enter a known Group name. 
 

Type 

Enter a receptacle type such as Genetix Plate 96X6010. 
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Search by Samples: 

 
Figure 9: Search by Samples 
 
Accession  
Enter a known accession number. 
 

Description 
Enter text known to be in a sample’s description field. 
 

Name 

Enter text known to be in a sample's name field. 
 

Annotation 

Enter text known to be in a sample's annotation field. 

 

Search by property value 

Search for samples containing properties of interest. Select a custom property from the  
drop-down list, choose a comparison operator from the list and enter the search criteria. 
 

Restrict search to group 

Tick this box to limit the search to one specific group, then choose the group from the  
drop-down list. 
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Match partial words  
Tick this option to allow the search to locate samples using a given set of characters within any 
string. For example, if Genetix Plate is entered, all receptacles of Type Genetix Plate will be 
listed. 
 

Search 
Click this button to activate the search based on the given criteria. 
 

View 
The View menu enables selected items to be viewed and shows how library information is 
displayed. 

 
Figure 10: View Menu 
 
 
Back 
Click this to revert to the previous view, continue to click it to move through previously viewed 
screens in sequence. 
 

Forward 
Click this to move up through the screens in sequence to the most recently displayed one. 
 

Up One Level 
Moves the current view to the next level up in the hierarchy. 
 

Home 
Select this option to close the search window and return to “Groups” view. 
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Large Icons  
Default view, groups or receptacles are displayed as icons with the name underneath. 
 

Details 
Receptacles or Wells and associated information are displayed in table format.  

 

Plate 
Available if a plate is selected in the Navigation pane. The plate layout is displayed in the 
Information pane, as you click on a well location, information about the well is shown in the 
status bar at the bottom of the window. 
 

Rearraying Checkout 
Samples that have been selected for inclusion in a rearraying file are listed in a separate pane in 
the lower part of the Data Tracking window (see Rearraying below). 
 

Refresh 
Updates the screen display. 
 

Tools 

 
Figure 11: Tools Menu 
 
 
Import Process File 
Import either – a Data Tracking process file (in XML format), which is the result of a process 
previously carried out by your Genetix robot (e.g. Picking, Gridding etc.) – or a QSoft Library 
Manager file (which has a .txt extension). The QSoft Library Manager file format can be used to 
import data from an external source such as LIMS or Excel. For an example of the Library 
Manager file format, see Appendix A of this manual. 

A Windows Open File dialog box is displayed to allow you to browse to the folder where the 
import file is located. 
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Figure 12: Import Process File 
 
Drop down the “Files of Type” list and select the required file format then choose the file to be 
imported. 

 

Import Custom Properties 
Custom properties are values that can be applied to samples at a given location. For example, a 
plate reader can be used to obtain a set of readings for the samples in a well plate. If these 
values are imported into QSoft Data Tracking, they can later be used in searches to identify 
samples of interest. There are very few restrictions on the values that can be used for custom 
properties; for full details and for information about the format of the custom properties file, see 
Appendix B. 
 

Database Utilities 
Backup 
Creates a copy of the database, a dialog will prompt for a unique name to be entered for the 
backup. 

Restore 
Will recover a previously backed up database file. 

Delete 
Allows old database backups to be deleted. 
 

Purge Database 
This will clear all user data from the database. 

To limit the risk of accidently purging the database, log in as the System Administrator to use this 
option: 

 The default user name is sa 
 The default password is genetixsapw 
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Rearraying 

 
Figure 13: Rearraying Menu 
 
Add Sample 
Click this option to Add the highlighted sample(s) from the currently selected plate to the 
Rearraying checkout. Select several contiguous samples by holding down the Shift key, clicking 
the first sample in a block then clicking the last sample in the block. To select several non-
contiguous samples, hold down the Control key as you click each sample. 

Clear Checkout 
Will clear all samples from the rearraying checkout. 

Remove Sample 
This will remove selected samples from the rearraying checkout. Several samples can be 
removed at once by selecting them with Shift+click or Control+click in the same way as for 
adding samples. 

Create Rearraying File 
Select this option to write the contents of the Rearraying checkout to a text file. You will be 
prompted to enter a filename with a .IMP extension. The data from this file can then be used as 
input to a Rearraying routine on a Genetix robot. 
 

The Toolbar 
The toolbar provides shortcuts for the most commonly used commands. All have equivalent 
options in the menus: 

 
Figure 14: Toolbar 
 
Hold the mouse over any of the toolbar buttons for a few seconds and a "Tooltip" will be 
displayed to indicate the name of the button. 
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Using QSoft Data Tracking 

Flow of Sample Data 
The diagram in Figure 15 describes the role of QSoft Data Tracking in the processes performed 
on sample data. This is described in more detail below. 

 
Figure 15: Flow of Sample Data 
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Create Samples 
The samples can be entered into Data Tracking via one of two routes, either automatically - from 
a Picking run on a Genetix robot or manually - imported from another data source.  

QSoft Picking software tracks the samples replicated from bioassay trays to well plates. This 
tracking information is stored in a process file in xml format (with a filename which ends 
DT.XML). The file contains information which uniquely identifies every sample with each 
individual replication carried out.  
 

Apply Attributes to Samples 
It is possible to create a Custom Properties file to contain searchable attributes about specific 
samples. This is a comma-separated text file with user-defined fields which hold values for each 
sample well e.g. A plate reader may generate some data for a well which can then be imported 
to the database. 

The format of the Custom Properties file is described in Appendix B. 
 

Import Sample Data 
The xml process file is imported into QSoft Data Tracking. 

It is possible to manually import a process file created using QSoft Library Manager (the 
predecessor of QSoft Data Tracking) or by converting a file from an external source (such as 
LIMS or Excel) into Library Manager file format. This file will be converted to XML format by the 
Data Tracking software. 

For an example of the Library Manager file format, see Appendix A of this manual. 

To import a process file, open the File menu and select Import Process File. 

 
Figure 16: Import Process File 
 
Browse to the location of the process file and select the file type from the drop down list. 
Highlight the import file name and click Open. 
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Process/Interrogate the Data 
To locate a sample, either browse through the groups in the Navigation pane of the application 
window or use the Search facility. For detailed information of the search facility, see the section 
headed Search on page 11. 

To view or edit the properties of a sample, right click with the mouse on the selected sample. 
The following shortcut menu is displayed. 

 
Figure 17: Sample Shortcut Menu 
 
 
Sample Properties 
A dialog similar to this one will appear. 

 
Figure 18: Sample Properties 
 
 
To edit a property value, double-click the relevant item and type in the new value. Add or amend 
the annotation associated with the sample.  

Click OK to store the information. 
 

Export the Data for Further Processing 
The resulting data from a Sample Search by Property Value can be written to a Rearraying 
Import file for further processing. To do this, either right-click a sample and select Send to 
Rearraying Checkout from the shortcut menu (see Figure 17 above) or highlight (select) a 
sample from the list and use the options in the Rearraying menu (as described in the section 
describing the Rearraying menu on page 16). 
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Figure 19: Example Search 
 
Add samples using the options from the Rearraying menu and create the Rearraying file as 
described on page 16. 
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Glossary of Terms 
Array 
Nylon filter or slide on which the clones are immobilized or array of DNA/protein spots on a glass 
slide. 

 

Arrayed 
Distribution of colonies or samples into known positions from 96 or 384 well plates. 

 

Base Class 
Blueprint for the properties of an object. 

 

Bioassay Tray (QTray) 
22x22 cm clear plastic tray from which colonies/phage are picked. 

 

Bioassay Tray Holder 
Perspex holder fitted to the robot bed for holding two Bioassay trays in place whilst carrying out 
a Picking routine. 

 

Block 
A pattern of clones or spots immobilized within an array produced by one pin. 

 

Blue/White 
Blue White selection protocol for visualization of colonies expressing -galactosidase. 

 

CCD Camera 
Charge Coupled Device Camera. A cooled digital camera for capturing high-resolution images 
with a wide dynamic range. 

 

Clone 
A particular DNA moiety contained within a DNA vector and propagated in a host cell. 

 

Compressing 
Converting 4 x 96 well plates into 1 x 384 well plate etc. 

 

Custom Property 
A custom property is a value that you can apply to samples at a given location in order to use 
later in the Data Tracking search facility. 

 

Datum Point 
A series of X, Y, Z co-ordinates that define a set position on the Robot bed. 
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Destination Plate Holders 
Holders for microplates located on the bed of the robot. The number of Plate Holders available 
depends on which robot is being used. 

 
DMF 
Dimethyl formamide. 

 
Expanding 
Converting 1 x 384 well plate into 4 x 96 well plates etc. 

 

Field 
An array is divided into fields. The field is the area covered by the head. 

 

Filter Block 
Solid blocks onto which gridding membranes are placed (2 per QPix). 

 

GFP 
Green Fluorescent Protein. Used to monitor subcellular protein localization, analyze differential 
gene expression. Protein interactions and cell transfection efficiency. 

 

Gridding head 
Head used for gridding and replicating. Available in 96 pin or 384 pin formats, either sprung or 
gravity. 

 

Guide Spot 
A reference spot created by the user, in order to make grids (arrays) easier to read. 

 

Hybridization intensity  
(as judged by pixel intensity) is a measure of gene activity. 

 

I/O 
Inputs / Outputs. 

 

IPTG 
Isopropyl-thio--D-galactoside. 

 

LB 
Luria-Bertani Medium. 

 

LIMS 
Laboratory Information Management System 
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MADGE 
Microplate Array Diagonal Gel Electrophoresis. 

 

Marker Spot 
A reference spot created by the user, in order to make grids (arrays) easier to read. 

 

Multi-spot pin 
Microarray pin which is loaded with a volume of sample which is then dispensed in aliquots. 

 

Phage 
Bacteriophage. 

 

Picking Tray 
See Bioassay Tray Holder. 

 

Probe 
A labeled DNA or RNA used to hybridize to an array . 

 

Process (Data Tracking) 
A routine performed on the data or an import from a file in QSoft Library Manager format. 

 

QSoft Library Manager  
This is the predecessor of QSoft Data Tracking. 

 

QSoft.DLL 
ActiveX software component housing all the functionality of robot software. 

 

Rearraying 
Redistribution of selected colonies into new plates performed with picking head. 

 

Receptacle 
Container used in Data Tracking - such as well plate, bioassay tray, slide or filter. 

 

Replicating 
To copy, compress or expand 96 or 384 well plates. 

 

Script 
Listing of all moves needed to complete a routine. 
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Spot 
Corresponds to a visual hybridization imprint of a clone with a probe. 

 

SSC 
Sodium Chloride/Sodium Citrate buffer. 

 

Sub-Grid 
(See Block) 

 

X Drive 
Axis running from back to front of the QArray Mini bed or right to left on any other bench-top 
robot. 

 

XML 
Extensible Markup Language. A simple text format derived from SGML Originally designed to 
meet the challenges of large-scale electronic publishing, XML is also used in the exchange of a 
wide variety of data on the Web. 

 

Y Drive 
Axis running from left to right across the QArray Mini bed or back to front on a bench-top robot. 

 

Y2H 
Yeast 2-Hybrid. Screening of ‘prey’ proteins encoded by cDNA libraries for interaction with a 
particular ‘bait’ protein. 

 

Z Drive 
Axis running vertically on the Robot bed. 
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Appendix A 

QSoft Library Manager 
Export a file from QSoft Library Manager 
To export a file from QSoft Library Manager, open the File menu and select Export Data – QSoft 
Library Manager will prompt you for a file name (with a .txt extension). A message will confirm 
that the Export operation was successful. 

QSoft Library Manager File Format 
Comment lines can appear anywhere in the file and must be prefixed with // 

The first meaningful statement specifies the group name 

e.g. 

LibraryName: Example One 

The next meaningful statement specifies the plate type in this library 

e.g. 

PlateType: Genetix 96 

Subsequent lines describe Plate/Well information  in the following format 

LibraryPlateName,Barcode,WellName,SampleID,AccessionNo,Comment 

e.g. 

EXAMPLE_PLATE_1,98765432,A1,Tomato,XX0099P11,Meaningful remark 

Barcode, Sample ID, Accession no. and Comments are optional fields and therefore may be 
omitted however the comma separators must still be present 

e.g. 

EXAMPLE_PLATE_1,,A1,,, 

Example QSoft Library Manager File 

 

//GENETIX LIBRARY MANAGER FILE 

// 

//Comments are prefixed // 

//Note: this file must consist of the following format: 

//LibraryName: Test Library 

//PlateType: Genetix 96 

// 

//Plate/Well format as follows: 

//LibraryPlateName, Barcode, WellName, SampleID, AccessionNo,Comment 

// 

LibraryName: EXAMPLE ONE 

PlateType: Genetix 384 

// 
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EXAMPLE_PLATE_1.1,98765432,A1,Tomato,XX0099P11,Descriptive remark 

EXAMPLE_PLATE_1.1,98765432,A2,Cress,ZZ9900X22, 

EXAMPLE_PLATE_1.1,98765432,A3,, 

EXAMPLE_PLATE_1.1,98765432,A4,Barley, 

EXAMPLE_PLATE_1.1,98765432,A5,, 

EXAMPLE_PLATE_1.1,98765432,A6,, 

EXAMPLE_PLATE_2.1,,B7,, 

EXAMPLE_PLATE_2.2,,B9,, 

EXAMPLE_PLATE_2.3,,H6,Tomato, 

EXAMPLE_PLATE_2.4,,H11,Red Pepper, 

EXAMPLE_PLATE_6.1,,,, 

EXAMPLE_PLATE_7.1,,,, 



 
 
 
GENETIX > COLONY PICKERS QSOFT DATA TRACKING APPLICATION GUIDE  
 
 
 

 
 
 

27 of 31 

Appendix B 

Example Custom Properties file 
This is a comma-separated text file. The Barcode field and the Location field are required and 
must be the first 2 fields respectively. Subsequently there must be at least one more user-
defined field to store custom properties. Data Tracking will automatically determine the data type 
stored in a user-defined field (string, floating point number etc). It is possible to add several 
hundred user-defined fields if required. 

The first row of the file contains the field names separated by commas. Subsequent rows contain 
the data for each field. The Barcode field and the Location field must not be left blank, any user 
defined field may be left blank but the comma to indicate the division between fields must still be 
present. See example below. 

 

Barcode,Location,Positive,Name,Age 

25/02/2002 10:41:59:1,A1,TRUE,well a1,5 

25/02/2002 10:41:59:1,B4,,,23 

25/02/2002 10:41:59:1,D2,FALSE,well d2,56.4 

25/02/2002 10:41:59:1,F6,,,2 

25/02/2002 10:41:59:1,E14,TRUE,well e14,19 

25/02/2002 10:41:59:1,C2,,,2 
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Appendix C 

XML Schema 
XML (Extensible Markup Language) (XML) is a simple, flexible text format derived from SGML. 
Originally designed to meet the challenges of large-scale electronic publishing, XML is also 
playing an increasingly important role in the exchange of a wide variety of data on the Web and 
elsewhere. 

XML Schemas express shared vocabularies and allow machines to carry out rules made by 
people. They provide a means for defining the structure, content and semantics of XML 
documents.  

Below is the schema used by Genetix for data exchange, this can also be found at the following 
web page www.genetix.com/schemas/genetix-process-1.0.xsd 

 
<?xml version="1.0" encoding="UTF-8" ?>  

<xs:schema xmlns:xs="http://www.w3.org/2001/XMLSchema" elementFormDefault="qualified"> 
<xs:element name="annotation" type="xs:string" />  
<xs:element name="description" type="xs:string" />  
<xs:element name="process"> 

<xs:complexType> 
<xs:sequence> 

<xs:element ref="description" />  
<xs:element name="starttime" type="xs:dateTime" />  
<xs:element name="robotname" type="xs:string" />  
<xs:element name="modulename" type="xs:string" />  
<xs:element name="softwareversion" type="xs:string" />  
<xs:element name="operator" type="xs:string" />  
<xs:element name="runnumber" type="xs:integer" />  
<xs:element name="group" type="xs:string" />  
<xs:element name="createsamples" type="xs:boolean" />  
<xs:element name="contents"> 

<xs:complexType> 
<xs:choice minOccurs="0" maxOccurs="unbounded"> 

<xs:element name="receptacle"> 
<xs:complexType> 

<xs:sequence minOccurs="0"> 
<xs:element ref="description" minOccurs="0" />  
</xs:sequence> 
<xs:attribute name="subtype" type="xs:string" use="required" />  
<xs:attribute name="columns" type="xs:integer" use="required" />  
<xs:attribute name="rows" type="xs:integer" use="required" />  
<xs:attribute name="barcode" type="barcode" use="required" />  
<xs:attribute name="type" type="xs:string" use="required" />  
<xs:attribute name="group" type="xs:string" use="required" />  

</xs:complexType> 
</xs:element> 
<xs:element name="sample"> 

<xs:complexType> 
<xs:sequence minOccurs="0"> 

<xs:element ref="description" minOccurs="0" />  
<xs:element ref="annotation" minOccurs="0" />  
<xs:element ref="property" minOccurs="0" maxOccurs="unbounded" />  

</xs:sequence> 
<xs:attribute name="barcode" type="barcode" use="required" />  
<xs:attribute name="location" type="location" use="required" />  
<xs:attribute name="accessionnum" type="xs:string" use="required" />  
<xs:attribute name="name" type="xs:string" use="required" />  

</xs:complexType> 
</xs:element> 
<xs:element name="replicate"> 

<xs:complexType> 
<xs:attribute name="srcbarcode" type="barcode" use="required" />  
<xs:attribute name="sourcelocation" type="location" use="required" />  
<xs:attribute name="destbarcode" type="barcode" use="required" />  
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<xs:attribute name="destlocation" type="location" use="required" />  
</xs:complexType> 

</xs:element> 
<xs:element name="location" minOccurs="0" maxOccurs="unbounded"> 

<xs:complexType> 
<xs:sequence minOccurs="0"> 

<xs:element ref="property" minOccurs="0" maxOccurs="unbounded" />  
</xs:sequence> 
<xs:attribute name="barcode" type="barcode" use="required" />  
<xs:attribute name="location" type="location" use="required" />  

</xs:complexType> 
</xs:element> 

</xs:choice> 
</xs:complexType> 

</xs:element> 
<xs:element name="finishtime" type="xs:dateTime" />  

</xs:sequence> 
<xs:attribute name="guid" type="xs:string" use="required" />  

</xs:complexType> 
</xs:element> 
<xs:element name="property"> 

<xs:complexType> 
<xs:simpleContent> 

<xs:extension base="xs:anySimpleType"> 
<xs:attribute name="name" type="xs:string" use="required" />  
<xs:attribute name="type" type="xs:string" use="required" />  

</xs:extension> 
</xs:simpleContent> 

</xs:complexType> 
</xs:element> 
<xs:simpleType name="barcode"> 

<xs:restriction base="xs:string"> 
<xs:minLength value="1" />  

</xs:restriction> 
</xs:simpleType> 
<xs:simpleType name="location"> 

<xs:restriction base="xs:string"> 
<xs:minLength value="1" />  

</xs:restriction> 
</xs:simpleType> 

</xs:schema> 
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Contact Details 
Corporate Headquarters 
Genetix Ltd 
Queensway, New Milton 
Hampshire BH25 5NN, UK 

Tel: +44 (0) 1425 624 600 
Fax:  +44 (0) 1425 624 700 

 

Visit www.genetix.com for contact details of your nearest Genetix sales and support. 

 

 
Trademarks 

ClonePix™ FL, CloneSelect™Imager, CellReporter™, HalfBD®, 'NRich®, SlidePathTM, Data ArenaTM and Image ArenaTM are trademarks of 
Genetix Ltd., UK 

CytoVision®, Ariol®, CytoNet® and CytoTalk® are registered trademarks of Genetix Corp. 

All third party trademarks are the property of their respective owners. 
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